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OVERVIEW 
 
 
 
Tick-It! Trak Pro Software Modules 
 
The Tick-It! Trak Pro system consists of software modules that are purchased and deployed to provide the functionality 
required for the intended application.  At a minimum, there are three modules that are required to deploy the system, and 
they are indicated as such below.  The modules are: 
 
The ADMIN Module (required) 
The POS Module (required) 
The REPORT Module (required) 
The INVENTORY Module (optional, but needed for retail sales operations) 
The VALIDATION Module (optional, but needed for Census tracking) 
The PACKAGE Module (optional, but needed for easy multiple event sales and seat renewals) 
The INTERNET TICKETING ASP Application (optional, but needed for Web Based Sales, if desired) 
The CRYSTAL REPORTS writer from Crystal Decisions  (optional, but strongly recommended, as it is needed for custom 
reporting, if desired) 
 
A brief description of the functions of each module follows: 
 
The ADMIN Module 
This is the module that supervisors or administrators use to set up Attraction Schedules, Ticket Prices, Ticket Designs, 
POS Station Options, Operator Security settings and other manager duties.  From this module your season of attractions 
is entered and maintained.  
 
The POS Module 
This is the Point of Sale interface, which allows transactions to take place.  It is written to take advantage of touch screen 
stations, although a standard keyboard and mouse will also work.  This is the module that does the actual transactions 
with the public, selling tickets, refreshments, souvenirs, etc. 
 

The REPORT Module 
This is another management tool that allows you to produce a variety of pre made and custom reports.  All the reports of 
the Tick-It! Trak Pro system are designed and maintained using Crystal Reports, and can be modified using that 
program.  Crystal Reports is available separately from Business Objects.  In many organizations, there is usually a copy 
of Crystal Reports already on hand.  It is a very common report writing program. 
 

The INVENTORY Module 
This module allows you to enter inventory items for retail sale, and to lay out and configure your POS Station Menus for 
sale of such items.  You can maintain lists of suppliers (vendors), issue purchase orders to them and receive inventory 
from them. This is the module covered by this manual 
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The VALIDATION Module 
The Validation Module is an interface for “scanning” barcodes on your tickets to record and track actual usage.  This 
module can be used manually, with an attendant scanning tickets or entering in the ticket ID number, or this module can 
be interfaced to custom turnstiles, which will unlock automatically upon presentation of a valid ticket.  In amusement park 
environments, season passes and multi-use tickets are often issued, frequently in the form of tough plastic cards.  As long 
as they have the proper barcode issued by Trak Pro, this module will read them like any other ticket. 
 

The PACKAGE Module 
The Package Module allows you to sell flexible, multiple attraction packages in a few steps.  With the Package Module, 
you can re-assign the same seats to your customer (if available) from one season to the next.  You can mix venues, mix 
seating types, allow for “Customer Chooses X Attractions from Y Selections”, specify revenue splits and more. 
 

The KIOSK Module 
The Kiosk Module allows you to set up self service stations so that customers may purchase tickets with a credit card.  As 
of this writing, this module is still under development. 
 

The INTERNET TICKETING ASP Application 
This is an independent web based application based on Microsoft’s IIS Active Server Pages technology.  This application 
is licensed for use on your server on a per transaction basis.  A server within your domain becomes your 24/7 Internet 
ticketing processor.   Ticket sales are performed using your live database and are recorded in real time.   Users can select 
their seats after seeing the view from a given section.   

CRYSTAL REPORTS from Crystal Decisions 
This is the report writer used by the Tick-It! Trak Pro system.  Existing reports can be modified, and new ones created.  
While strictly speaking it is an optional component, it is strongly recommended that you get a copy of this.  As mentioned 
above, this is an industry standard report writer, and you might want to inventory your own software, to check to see if you 
already own this package.  You might be surprised to learn you already have it. 
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Accessing the Inventory Module 
 
MONTY: PICTURE HERE 
 
From the ADMIN Module Menu, select POS Functions. Then, Select Concessions and Inventory.  
 
This opens the Inventory Module.  You will see a screen similar to this:  
 
MONTY: PICTURE HERE 
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The Main Menu – Overview  
The Main Menu is where you select from the primary functions of the Inventory Module 

 
There are 6 choices: 
 
The File Menu 

 
The only function in the File Menu is to Exit the 
Program. 
 
 

The Inventory Menu 
 
This menu allows you to enter, edit or view 
Inventory Items and Related Records 
 
 
 
 
 
 
 
 

The POS Menu 
 
 
The POS menu is where you define your 
Retail Point of Sale screens 
 
 
 
 
 
 
 

The Options Menu 
 
This menu allows you to set various 
options for the Program. 
 
 
 
 

The Help Menu 
 
 
 
 
Here is where you access the help 
reference, enable or disable tips, and 
view program version and system 
information. 
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The Inventory Menu 

 
 
Use the Inventory Section to take care of anything relating to Retail Inventory.  Create or edit Inventory Records, Manage 
Purchase Orders, set up Suppliers (Vendors), etc.  
 
Create / Edit / Delete Inventory Items 
From the Inventory Menu, click on “Create / Edit / Delete Inventory Items.” You will be presented with this screen:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on “New Product” to 
create a new product record 
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You will be presented with a Blank Inventory Record.  Fill in the information. Pictured below is a sample inventory record, 
a concession size package of Reese’s Peanut Butter Cups. 

 
 
The ID Number is generated by the 
program. It is shown for reference 
only.   
 
Enter the name, description, current 
quantity on hand, reorder point, 
reorder quantity, unit cost, units per 
package, package cost, supplier 
stock number and retail price. 
 
 
 
 
 
 
 
 
 

IMPORTANT TIP: 
Notice that we DID NOT type in the apostrophe ( ‘ ) in the name REESES.  The apostrophe is used by many SQL engines 
to mark the end of a text string.  Many also use the double quote character ( “ ).  AVOID TYPING apostrophes and 
quotes.  It will save you trouble later. 
 
Select a category for the inventory item or create a new category for the item. Select a principle supplier for the item, or 
create a new supplier for the item. 

Click on the PICTURE tab, to view a 
graphic image or assign an image for 
the item.  This can help educate new 
employees by showing them 
EXACTLY what item the record 
represents 
 
Pictured here is the image that has 
been assigned to our Reese’s Cup 
record.  There is little doubt as to 
what item the record represents 
 
 
 
 
 
 
 

Related Topics: 
Searching for Inventory Records 
Inventory Categories 
Supplier Records 
Common Database Record Controls 
The Inventory Menu 
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Searching for Inventory Items 
Whenever you need to locate an inventory item record for any purpose, such as editing the record, or creating a purchase 
order, you will be presented with the “Search Screen”: 
 

 
In the example 
above, we have 
selected a 
specific 
inventory 
category 
CANDY.   
 
 
You could 
further limit the 
search by 
entering in text 
and selecting a 
filter field.  After 
you set the 
search criteria, 
Click on the big 
SEARCH NOW 
button to view 
the results. 
 
 
 
 
 
 
 
 
 
 
 

 
When you ask for a text search, for example, by Product Name, the program will find all product names that BEGIN with 
the text you have entered.  If you entered BL for your search text, the program would select: 
 
BLACKBERRY 
BLIMP 
BLUEBERRY 
BLUENOSE 
 
Use a “wild card” for broader text searches.  The wild card character is the percent sign ( % ).  By entering the wild card 
character IN FRONT of your search text the computer will find items that have the text ANYWHERE in the search field, 
not only the beginning.  If you entered %AC for your search text, the program would select: 
 
ACME BATTERIES 
ACTION FIGURE 
VACCUUM CLEANER 
VALUE PACK 
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Select a record by clicking on the line item to highlight the row. Then click on THIS PRODUCT. Or, double click on the 
“record selectors” on the left hand side of the list.  Select multiple records by clicking on the record selectors while holding 
the CTRL button on your keyboard: 
 

 
 
Related Topics: 
Inventory Records 
The Inventory Menu 
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Creating a Purchase Order 
 
Trak Pro can assist you in creating Purchase Orders for your Suppliers.  The form is divided into two parts: 
 

 
Select the Supplier from the Pull Down list.  If you are placing an order to a Supplier not currently in the system, create a 
new Supplier Record.  Click on the button next to the pull down list and The Bill to and Ship to addresses fill in for you 
automatically, based on entries in your Company Information record.  Edit if necessary. 
 

Select items 
to enter in 
your PO by 
double 
clicking on 
the record 
selectors in 
the Inventory 
Browser.   
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When you select an item, a window will pop up, prompting you to fill in specific ordering information, as shown here: 
 

 
 
The dollar amount of your order will be totaled for you automatically.  You may also enter any shipping or misc. fees as 
shown. 
 
When finished, click the CLOSE button.  You will be asked to confirm that you are finished with the PO.  You will also be 
given the option to print the PO.  If you elect to print, you will be taken to the Report Preview Panel, to view the PO before 
sending it to your printer. 
 
 
Related Topics: 
Browsing Purchase Orders 
Inventory Records 
The Inventory Menu 
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 Browsing Purchase Orders 
 
View issued Purchase Orders using the Purchase Order Browser, pictured below: 

 
To limit your search, FILTER your POs: 
 
View ALL Purchase Orders 
View COMPLETED Purchase Orders 
View INCOMPLETE Purchase Orders 
 
Or, SORT your POs: 
 
Descending PO Number (most recent on top) 
By Supplier 
By Ascending Required Date (things needed first on top) 
 
Double click on the record selector to bring up the PO for modification or printing.   
 
To create a NEW PO, Click on the CREATE NEW PURCHASE ORDER button. 
 
To  BROWSE INVENTORY LEVELSclick on the BROWSE INVENTORY LEVELSbutton. 
 
Related Topics: 
Creating a Purchase Order 
The Inventory Menu 
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Selecting a Purchase Order for Receiving 
 
When you place orders with your suppliers, merchandise arrives.  .  The process of recording your shipments and 
updating your database is referred to as “Receiving Items into Inventory”.  Your first step from this screen is to either click 
on the FIND ITEM button to search through your inventory records, or scan or enter the Inventory ID: 
 

 
 
In this example, we are receiving a case of 144 “Hot Tamale” candies.  If you are receiving an item that has no inventory 
record, create a record by clicking on the CREATE NEW ITEM button Enter the appropriate information.  In this example, 
the case was $129.60, or 90 cents each.  Once you enter the shipment and pricing information, click on the RECEIVE AS 
SHOWN button.  
 

 
 
At this point, the computer will search for any outstanding Purchase Orders that are “expecting” this item. If there are any, 
you will be presented with a list to choose from.  Select the Purchase Order to receive against.  The computer will update 
the records.  In this example, we are receiving against PO # 35, issued to the Candy and Popcorn dot com company. 

 
 
 
After your item records are updated, you will see this confirmation 
message. 
 
 
 

 
Related Topics: 
Browsing Purchase Orders 
Creating a Purchase Order 
The Inventory Menu 
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The Crystal Report Viewer 
 
The Purchase Order Forms generated by the Tick-It! Trak Pro Inventory Module are created and maintained using the 
Crystal Reports Designer, available from Crystal Decisions. 
(their website is www.CrystalDecisions.com) 
 
When you run a Purchase Order Crystal Report from the Inventory Module, a Preview Form will appear, much like the one 
you see below: 
MONTY: PICTURE {BMC ReportViewer1.bmp} 
 
By default, the viewer will set the scaling to attempt to show you the entire page of the report, assuming that it is formatted 
for an 8 ½ by 11 sheet of paper. 
 
Along the top you will see a set of controls that allow you to do some pretty neat things with the report you are previewing. 
 
Here are the controls in detail: 
 
MONTY: PICTURE {BMC ReportViewer2.bmp} 
 
Click on the printer icon to send the report to your default printer. (Change the printer by clicking on the PRINTER button 
at the bottom of the viewer.) 
 
Click on the envelope icon allows you to export the report in a variety of formats, and send the exported file to a disk, or 
email the file to someone. You must have the appropriate email client and web connection available to send the file. 
 
Click on the little lightning bolt icon to re-generate the report, using the most current data.  This is useful in networking 
environments, where transactions could be occurring all the time, and you want to see the latest results. 
 
The pull down control with the percentages allows you to set the “zoom level” of the preview.  Enlarge or shrink the report 
image depending upon your computer’s video hardware and your eyesight! 
 
The middle controls are for page navigation through the report. 
 
The icon with the magnifying glass allows you to search for and locate an item of interest in a lengthy report. 
 
 
Related Topics: 
The Inventory Menu 
Creating a Purchase Order 
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Inventory Level Browser 
 
You can scan through your Inventory Levels using the Inventory Level Browser, pictured below: 
 

 
You can filter the 
list in several 
ways: 
 
Restrict the list to 
a specific supplier 
and/or 
Restrict the list to 
a specific product 
category (in the 
example above 
we are only 
looking at 
CANDY) and/or 
Restrict the list to 
show only items 
at or below their 
re-order points. 
 
 
Double click on 
the record 
selector to bring 
up the Inventory 
Record. 
 
 

If you need to order more of an item, create a purchase order by clicking on the “Create New Purchase” button.  
 
Related Topics: 
Inventory Records 
The Inventory Menu 
Creating a Purchase Order 
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Receiving Items into Inventory 
When you place orders with your suppliers, merchandise arrives.  The process of recording merchandise received and 
updating your database is called “Receiving Items into Inventory”.  From the Inventory Menu, Select Receive Inventory. 
Click on the FIND ITEM button to search through your inventory records or scan or enter the Inventory ID: 

 
 
In this example, we are receiving a case of 144 “Hot Tamale” candies.  If you are receiving an item that has no inventory 
record, create a record by clicking on the CREATE NEW ITEM button Enter the appropriate information.  In this example, 
the case was $129.60, or 90 cents each.  Once you enter the shipment and pricing information, click on the RECEIVE AS 
SHOWN button.  
 

 
 
At this point, the computer will search for any outstanding Purchase Orders that are “expecting” this item. If there are any, 
you will be presented with a list to choose from.  Select the Purchase Order to receive against.  The computer will update 
the records.  In this example, we are receiving against PO # 35, issued to the Candy and Popcorn dot com company. 

 
 
 
After your item records are updated, you will see this confirmation 
message. 
 
 
 

 
Related Topics: 
Inventory Records 
Creating a Purchase Order 
Browsing Purchase Orders 
The Inventory Menu 
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Inventory Records 
Pictured below is a sample inventory record, a concession size package of Reese’s Peanut Butter Cups. 

 
 
The ID Number is generated by the 
program. It is shown for reference 
only.   
 
Enter the name, description, current 
quantity on hand, reorder point, 
reorder quantity, unit cost, units per 
package, package cost, supplier 
stock number and retail price. 
 
 
 
 
 
 
 
 
 

IMPORTANT TIP: 
Notice that we DID NOT type in the apostrophe ( ‘ ) in the name REESES.  The apostrophe is used by many SQL engines 
to mark the end of a text string.  Many also use the double quote character ( “ ).  AVOID TYPING apostrophes and 
quotes.  It will save you trouble later. 
 
Select a category for the inventory item or create a new category for the item. Select a principle supplier for the item, or 
create a new supplier for the item. 

Click on the PICTURE tab, to view a 
graphic image or assign an image for 
the item.  This can help educate new 
employees by showing them 
EXACTLY what item the record 
represents 
 
Pictured here is the image that has 
been assigned to our Reese’s Cup 
record.  There is little doubt as to 
what item the record represents 
 
 
 
 
 
 
 

Related Topics: 
Searching for Inventory Records 
Inventory Categories 
Supplier Records 
Common Database Record Controls 
The Inventory Menu 
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Inventory Categories 
A limitless number of inventory item categories can be created to help you organize your inventory records.  Below is a 
typical list.  Depending on your operation, and the items you offer for sale, your categories may differ. 
 

 
 
ID Numbers for the categories are generated 
automatically.   
 
 
 
 
 
 
 
 
 
 

 
Enter the name of the category you want to create.  Either type directly into the NEW record indicated by the asterisk (*), 
or click the ADD button. 
 
 

 
NOTE: You cannot delete an Inventory Category if it is in use by any other records in your database. 
 
Related Topics: 
Inventory Records 
Searching for Inventory Records 
Common Database Record Controls 
The Inventory Menu 
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Suppliers (Vendors) 
Suppliers are where you purchase your inventory items for retail sales.  By entering in your supplier information, Trak Pro 
will assist you in creating purchase orders. 
 

 
 
Pictured here is a 
sample supplier 
record.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(Yes, there REALLY 
is a World Wide 
Ticket and Label. 
Contact them for 
High Quality 
Thermal Ticket 
Stock. Phone: 
877-426-5754.) 
 

Enter the expected contact information, along with any account number that the supplier may have assigned. 
 
Select a payment term for the supplier, or create a new payment term for the supplier. 
 
 
Related Topics: 
Inventory Records 
Common Database Record Controls 
The Inventory Menu 
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Searching for Suppliers (Vendors) 
To locate a supplier record, select POS functions from the ADMIN module. Next, select Inventory. Then, select Suppliers.  
You will be presented with the following “Search Screen”: 

 
Specific search 
criteria was not 
entered, which 
produces a list of all 
supplier records.  
Limit the search by 
entering in text and 
selecting a field to 
filter.  After setting 
your search criteria, 
click the SEARCH 
NOW button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When you ask for a text search, the program will attempt to find all names that BEGIN with the text you have entered.  If 
you enter BL for your search text, the program would select: 
 
BLACK BEARDS COSTUME SUPPLY 
BLIMPS R US 
BLOOMBERG INFO SERVICES 
BLUE BLOOD SUPPLY HOUSE 
 
Use a “wild card” for broader text searches.  The wild card character is the percent sign ( % ).  By entering the wild card 
character IN FRONT of your search text the computer will find items that have the text ANYWHERE in the search field, 
not only the beginning.  If you entered %AC for your search text, the program would select: 
 
ACME BATTERY COMPANY 
ACTION FIGURE EMPORIUM 
BILLS VACCUUM CLEANERS 
VALUE PACK SYSTEMS 
 
Select a record by clicking on the line item to highlight the row, then clicking on the THIS SUPPLIER button. Or, double 
click on the “record selectors” on the left hand side of the list. 
 
Related Topics: 
Supplier Records 
Inventory Records 
The Inventory Menu 
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Payment Terms 
When dealing with suppliers, you may have a variety of payment terms for each vendor.  Create a list of common 
payment terms, and you will not have to re-type the same phrase over again when generating purchase orders. 
 

 
The ID Numbers for the payment terms are 
generated for you automatically.   
 
Type in the description of the payment term you 
want to create.   
 
 
 
 
 
 
 
 
 
 

 
 
Either type directly into the NEW record indicated by 
the asterisk (*), or by clicking the ADD button. 
 
 
 
 
 
 
 

Related Topics: 
Supplier Records 
Creating a Purchase Order 
Common Database Record Controls 
The Inventory Menu 
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The POS Menu 

 
 
This section controls what is shown on the buttons of the POS Module for general retail sales operations.  For information 
regarding these menu selections, refer to the topics below: 
 
 Intelli-Menu Builder 
 POS Station Assignments 
 Sales Promotions 
 Broadcasts 
  Send a Broadcast 
  Broadcast Preset Messages 
  Clear All Broadcasts 
 
 
See Also: 
The Main Menu 
The Intelli-Menu Builder 
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The Point Of Sale Menu Builder 
 
The following Topics are available for Help: 
 

 

Learn about the Menu Builder Basics and overall 
operations: 
Menu Builder Overview 

  

 

Walk thru an example of adding an item (illustrated using 
Popcorn): 
Creating a POS Item Example (Popcorn) 

  

 

Learn about setting default button colors: 
Default Button Colors 

  

 

Learn about using the Concession Wizard to automatically 
build a menu for you: 
The Concession Wizard 

  

 

Learn about using the Souvenir Wizard to automatically 
build a menu for you: 
The Souvenir Wizard 
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Menu Builder Overview 
NCS calls its Point of Sale Menu the “Intelli-Menu”, because it is designed differently than other POS software menus.  
With the Intelli-Menu, the choices presented to the user during POS operations depend upon such factors as the 
privileges of the user and what station they are logged into.  The program rebuilds the POS menu every time someone 
logs in at a POS station, presenting only the choices for their security and station options.  The Intelli-Menu is built along a 
cascading, top down principle.  You begin from the top row of buttons and work downward.  Each selection you make 
presents additional selections, if available.  The operator is only looking at buttons needed to make decisions on the 
current item in the transaction.  Visual clutter is reduced, and operator sensory overload is diminished. 
 
Here is an illustration of the over-all Intelli-Menu Builder: 

 
 
The left side of the screen shows design controls.  These controls are not visible during normal POS operations.  The 
upper right portion of the screen shows your current, POS Menu.  It will look like the menu presented on the POS 
Stations, exception for the “NEW” buttons used to create new POS choices.  The lower right portion of the screen displays 
various controls and options when defining new POS buttons. 
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Here are the design control 
buttons found on the left hand side 
of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Here is an overview of the POS Menu Buttons, the levels at work during setup and normal sales operation: 
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Here is a POS Menu, using food concessions as an example. 

 
 
For any button that is NOT a Category, you can assign the following: 

A Label, such as HOT DOG or MEDIUM 
A Price, such as $2.50 
A List of Applicable Sales Taxes (if any) 
A List of Inventory Items to deduct (if any) 
A “Sort Position Order”, to help group like buttons together 
A Set of simple rules as to what to do when the button is selected. 

 
The rule that you will pay attention to the most often is the rule that determines whether or not a button can “complete” an 
item.  A CATEGORY button can never complete an item.  Here are some examples when a button can “complete” an 
item: 
 
Boxes of CANDY:  You offer big boxes of M&M’s or GOOBERS, etc.  For these menu items, each can be assigned to a 
button, given a price, and set to complete. The operator does not need to give any further information about the item. 
 
SOFT DRINKS.  You might offer PEPSI or COKE in a variety of sizes.  For the MENU ITEM buttons, you assign the 
labels PEPSI or COKE, but these buttons cannot complete an item.  The operator needs to indicate a SIZE for the soft 
drink, in order to assign a price, and any inventory items to pull (such as cups or lids).  In the SOFT DRINKS category, 
MENU ITEM buttons cannot complete items, but SIZE buttons can. 
 
You may assign foreground and background colors for each button created.   If you do not assign a color, the program will 
use the default color for the button level.  Set the default colors for the menu by clicking on  Default Button Colors. 
 
The Menu Builder contains two “Wizards” to help you jump-start your menu definition.  These wizards will create buttons, 
assign sizes and prices, and set up inventory items 
 
Related Topics: 
The Souvenir Wizard 
The Concession Wizard 
Inventory Records 
The POS Menu 
 
Default Colors for the POS Menu Buttons 
When designing your POS Menu, it is possible to assign a different color to every button you define.  However, you might 
not want to change every single button. Let the system default to a set of colors of your own choosing. 
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Click on the Default Color Button: 

 
You will see a mock up of the POS Screen.  Double click any of the elements to set a color for that element. 
 

 
 
 
We have preset some button color schemes for you.  These choices are Icy Blue, Valentine Pinks, and Irish Green. 
 

 
 
Here is  “Icy Blue”: 
 
When you are satisfied with the colors, save the color scheme as your “User Defined” color defaults. 
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Remember, these will be the colors used for buttons IF YOU DON’T SPECIFICALLY CALL OUT A COLOR.  Otherwise, 
whatever color you pick for a specific button is the color that will be used. 
 
Related Topics: 
The Intelli-Menu Builder 
The POS Menu 
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 The Concession Wizard 
To assist your menu operations, the Intelli-Menu Builder has a built in “Concession Wizard”.  From the POS Menu, Select 
Intelli-Menu Builder. 
 
Click on the Concession Wizard button: 
 

 
 
This starts the Wizard, and brings you to this screen: 
 
STEP 1: CATEGORY AND INVENTORY 
 

 
 
Place your new menu items in a NEW Menu Category (as shown in the example above) or in an existing Menu Category.  
Select the items you want to add.  Your choices are: 
 
Soft Drinks 
Food Items and 
Candy 
 
The Automatic Inventory option. 
  
When the Wizard creates Menu Items for you, it can also generate the appropriate inventory item records.  For example, 
the Wizard can add inventory records for soft drink cups, lids and straws, or buns and meat patties for burgers.  It is a 
quick shortcut for building your inventory records. 
 
In this example, we selected all the options, so you can see what the Wizard can do for you.  Click the NEXT >>> button: 
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STEP 2: SOFT DRINKS 
Pictured here is the Soft Drink Wizard panel.   

Choose from 45 
commonly offered 
soft drinks, and from 
8 different serving 
size options.  
 
Check the drinks 
and sizes you will 
offer.  
 
Enter the prices you 
will charge.  Select 
any taxes that will 
be applied to soft 
drink sales.   
 
Pictured here is the 
State Sales Tax., 
your sales may be 
tax exempt.   
 
Click on the NEXT 
>>> button 
 
 
 

STEP 3: FOOD / SNACKS 
 
This is the Food / 
Snacks Wizard 
panel.   
 
Choose from 6 
different food items 
typically offered at 
concession stands, 
along with sizes, 
prices and modifiers 
(like condiments 
and extras).  
 
Select the items you 
will offer. Fill in the 
prices, and set any 
sales taxes 
 
 
Click the NEXT >>> 
button. 
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STEP 4: CANDY 
 
Here is the Candy 
Wizard panel.   
Choose from 30 
different candy 
items typically 
offered at 
concession stands.   
 
 
Check the items 
you want to offer, 
fill in the prices, 
and set any sales 
taxes.   
 
 
 
 
 
 
Click the NEXT 
>>> button: 
 
 
 

STEP 5: CONFIRMATION 
You will receive the final confirmation screen before you build your concession menu.   

 
To make any 
changes, click on 
the <<< PREV 
button.   
If you are satisfied 
with your options, 
click on the FINISH 
button.Your 
concession menu 
will be constructed  
for you. 
 
 
 
 
 
 
 
 
 
 

Related Topics: 
The Souvenir Wizard 
The Intelli-Menu Builder 
Inventory Records 
The POS Menu
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The Souvenir Wizard 
The Intelli-Menu Builder has a built in “Souvenir Wizard” to assist in creating your retail souvenir menus.  From the POS 
Menu, Select Intelli-Menu Builder. 
 
Click on the Souvenir Wizard button: 
 

 
 
This starts the Wizard, and brings you to this screen: 
 
STEP 1: CATEGORY AND INVENTORY 
 

 
 
Place your new menu items in a NEW Menu Category (as shown in the example above) or in an existing Menu Category.  
Select which items you want to add in this session.  Your choices are: 
 
Apparel (T-Shirts, Hats, etc) 
Books / Videos / CD’s 
Toys / Postcards / Film 
 
The Automatic Inventory option. 
  
When the Wizard creates Menu Items for you, it can also generate the appropriate inventory item records.  For example, 
the Wizard can add inventory records for soft drink cups, lids and straws, or buns and meat patties for burgers.  It is a 
quick shortcut for building your inventory records. 
 
In this example, we selected all the options, so you can see what the Wizard can do for you.  Click the NEXT >>> button: 
 



Chapter 3 – POS Menu 

Inventory Manual Page 32 
Copyright 2004 New Concepts Software, Inc. 

 

 
 
STEP 2: APPAREL ITEMS 
This is the Apparel Wizard panel: 

 
Choose from 6 
different clothing 
items, and from 7 
size options, 
where 
appropriate.   
 
Check the items  
you will offer. 
Enter the prices 
you will charge.   
 
Select any taxes.  
Pictured above is 
the State Sales 
Tax. Your sales 
may be tax 
exempt.   
 
 
Click on the 
NEXT >>> 
button: 
 
 

 
STEP 3: BOOKS / VIDEOS / MUSIC 
This is the Books / Videos Wizard panel.   

 
Choose from 
Books, Videos 
and Music/Audio 
items. 
  
Check the items 
you want to offer. 
 
Fill in the names 
and prices, and 
set any sales 
taxes.  
 
 
: 
 
 
 
Click the NEXT 
>>> button 
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STEP 4: TOYS / FILM / BATTERIES 
This is the Toys / Film Wizard panel.   

 
Choose from 10 
different film 
items.Enter up to 
14 general retail 
items (they are 
listed as “Toys” in 
the Wizard, but 
they can be 
anything)  
 
Check the items 
you want to offer, 
fill in the prices, 
and set any sales 
taxes.  
 
 
 
 
Click the NEXT 
>>> button: 
 
 

STEP 5: CONFIRMATION 
 
This is the final 
confirmation step 
before you build 
your souvenir 
menu.  If you 
need to make 
changes, click on 
the <<< PREV 
button.   
When you are 
satisfied with 
your options, 
click on the 
FINISH button.  
Your souvenir 
menu will be 
constructed for 
you. 
 
 
 

 
Related Topics: 
The Concession Wizard 
The Intelli-Menu Builder 
Inventory Records 
The POS Menu 
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 Creating a POS Menu Item (POPCORN!) 
We are using popcorn as an example because almost everyone is familiar with this item. 
 
Our concession stand will offer popcorn in four sizes: 
 
A 10 oz “small” bag for $1.00 
A 20 oz “large” bag for $2.00 
A 32 oz “small” tub for $3.00 
A 64 oz “large” tub for $4.00 
 
Customers will want varying degrees of salt and butter on their popcorn, and we would like to record their selections using 
the POS system. 
 
For inventory control, we will have the computer deduct the appropriate container from inventory when a sale is made.  
So, when someone purchases a small tub of popcorn, the quantity of small paper tubs will be reduced by one.  Then, we 
will know when to order more tubs, or bags. 
 
Here is what we have: 
 
MENU ITEM: 
Popcorn 
 
SIZES: 
Small Bag 
Large Bag 
Small Tub 
Large Tub 
 
MODIFIERS: 
Salt 
Butter 
 
MODIFER MODIFERS: 
Extra 
No 
Heavy 
Light 
 
First, We Need a Category! 
 
Depending upon how you want your POS Menu organized, you will need to create a category appropriate for the 
POPCORN menu item.  Examples of such categories might be: 
 
“FOOD” 
“SNACKS” 
“CONCESSIONS” 
For our example, we will create a category called “FOOD”.  : 

 
 
Click on the “New Category” button 
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In the area below the POS Menu buttons, a dialog will appear allowing you to enter the specifics for the new category: 
 

 
The ID will be automatically assigned, and is shown for reference 
only.   
 
 
 
 
 
 

Type in any appropriate (short) phrase to fit on the category button.  In our example, we have typed “Food”.  The “Sort 
Position” is a number used to position buttons on the POS screen.  The lower the number, the closer to the left the button 
will appear.  We want “Food” to appear right after any ticketing category (if the POS Station can sell tickets as well). We 
have entered a Sort Position of 0 (zero).  If you are creating a category for restricted items, such as tobacco, check that 
option.  In this example, Food is an unrestricted category.  Any operator can view this category. 
 
If you want the button for the category to appear in a color other than the default colors, click on the “Button” and or “Text” 
buttons to set the button background color and button text color.  Once you have selected the colors, the buttons will 
change to preview the colors.  
 
The Menu Item 
 
When you see the buttons appear for the new category of “Food”, click on the “New Item” button: 
 

 
 
In the area below the POS Menu buttons, a dialog will appear allowing you to enter the specifics for the new item: 

 
 
The ID will be automatically assigned. 
It is shown for reference only.   
 
 
 
 
Type any appropriate (short) phrase to 
fit on the menu item button.  Here, we 
typed “Pop Corn”.  At this level, we 
are not going to assign a price to Pop 

Corn.  We will do that at the Size level.  Leave the Price field set to 0.00 (zero).   
 
The “Sort Position” is a number used to position buttons on the POS screen.  The lower the number, the closer to the left 
and top the button will appear.  We want “Pop Corn” to appear after more ”meaty” food items. We have entered a Sort 
Position of 8 (eight).   
Clicking “Pop Corn” is not sufficient to complete an item. You need to know what SIZE the customer wants in order to 
assign the proper price, and pull the correct container from inventory.  Leave the option for completing an item 
UNCHECKED, as shown.  If there were a special on Pop Corn, and you wanted the POS Module to display the button in 
the Highlighted Color, check the Highlight this Button option.  This is also a good way to remind sales staff about up-
selling. 
 
The Bar Code field is where you scan in the UPC code for the item, if it is a pre-packaged product.  Here the field is left 
blank. 
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The unlabelled pull down is for sales taxes.  In this example, we selected the State Sales Tax as applicable to this menu 
item.  Add as many taxes as appropriate for any menu item. 
 
If you want the button for the Menu Item to appear in colors other than the default colors, click on the “Button” and or 
“Text” buttons to set the button background color and button text color.  Once you have selected the colors, the buttons 
will change to preview the colors. You see how they will look before committing to them.  In this example, we have set the 
button to appear white, with black text.   
 
Click OK to save the button and re-generate the menu. 
 
When the buttons appear for the new category of “Food”, you should now see “Pop Corn” listed.  Click on the “Pop Corn” 
button: 
 

 
 
Item Sizes  
 
When the Size buttons appear for the new item of “Pop Corn”, click on the “New Size” button: 
 

 
 
 
The ID is automatically assigned, and 
is shown for reference only.   
 
 
 
Type in any short phrase to fit on the 
menu size button.  We typed “Small 
Bag”.  Set the price. We entered a 
price of one dollar (1.00).  The “Sort 

Position” is a number used to position buttons on the POS screen.  The lower the number, the closer to the left button will 
appear.  We want the size to appear from smallest to largest. We entered a Sort Position of zero (0).  Clicking “Small Bag” 
IS now sufficient to complete an item. CHECK the option for completing an item, as shown.  To display the button in a 
Highlighted Color, check the Highlight this Button option.  This is a good way to remind sales staff about up-selling.   
 
 
Click on the INVENTORY INFO tab at the top of this dialog: 
 

 
 
We want to deduct a single small paper bag from inventory each time a small bag of popcorn is sold.  Click on the Add 
Inventory Item button: 
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Browse the Inventory Records to locate the paper size.  For other sales items, designate any number of inventory items to 
be deducted during sales.  For example, a single “Hamburger” could be set to deduct one bun, one meat patty and one 
Styrofoam container.  Our popcorn example is a single bag. 
 
If you want the button for the Size to appear in colors other than the default colors, click on the “Button” and/or “Text” 
buttons to set the button background color and button text color.  Once you have selected the colors, the buttons will 
change to preview the colors, so you may see how they look before committing to them.  In this example, we are using the 
default “cyan” color. 
 
Click OK to save the button and re-generate the menu.  Repeat these steps for the Sizes of “Large Bag”, “Small Tub” and 
“Large Tub”. 
 
The Modifiers for the Item / Sizes 
 
When the buttons appear for the new category of “Food”, you should see “Pop Corn” listed.   

 
Click on the “Pop Corn” button: 
 
 
 
 
 
 
 

 
 
Click on the “Small Bag” button 
 
 
 
 
Click on the “New Modifier” button: 
 
 

 
 
 
The ID will be automatically assigned. 
It is shown for reference only.   
 
 
 
 
Type in any appropriate (short) phrase 
to fit on the menu modifier button.  We 
typed “Butter”.  Since we are not 

charging extra for butter, enter a price of 0.00 (zero).   
 
The “Sort Position” is a number used to position buttons on the POS screen.  The lower the number, the closer to the left 
button will appear.  We only are going to have two modifiers, namely Butter and Salt.  There is not a lot of concern about 
the Sort Order, so we entered a Sort Position of 0 (zero).  Enter 1 (one) for Salt.  Clicking “Butter” is not sufficient to 
complete an item, so, UNCHECK the option for completing an item, as shown above.   
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If there were a special on Small Bags of Pop Corn with Butter, and we wanted the POS Module to display the button in the 
Highlighted Color, check the Highlight this Button option.  This is a good way to teach your sales staff about up-selling.  
 
Since people can ask for things like HEAVY BUTTER or LIGHT SALT, we want the “Modifier Modifier” buttons to be 
active.  We checked the option that the Modifier can be Modified. 
 
If you want the button for the Menu Item to appear in colors other than the default colors, click on the “Button” and or 
“Text” buttons to set the button background color and button text color.  Once you have selected the colors, the buttons 
will change preview the colors, so you may see how they will look before committing to them.   
 
In this example, we set the button to appear pale yellow, with black text.  We hope the color pale yellow will be associated 
with “Butter” in the user’s mind, making the selection process a little more intuitive. 
 
Click OK to save the button and re-generate the menu.  Repeat these steps for the SALT modifier. Repeat all the steps for 
each size.  (Each size for an item can have unique modifiers, so you must enter them) 
 
Related Topics: 
The Intelli-Menu Builder 
The POS Menu 
Searching for Inventory Records 
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Defining POS Reminder Messages 
 
The bottom of the POS Screen is reserved for messages.  These messages can be important broadcast messages from 
other stations or administrators.  When no messages are pending in the broadcast queue, the POS station will rotate 
through a list of reminder messages.  These messages can be training aids, or cheerful pick-me-ups. 
 

 
 
Enter any number of 
messages that you want to 
rotate through at the 
bottom of the POS Screen.   
 
Use seasonally appropriate 
messages for the holidays, 
or special sales events, 
whatever.   
 
 
Change the messages as 
often as you like.   
 
 
 
 
 
 
 
 

 
Related Topics: 
The Intelli-Menu Builder 
The POS Menu 
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POS Station List 
 
From the ADMIN Module or the INVENTORY Module, you can define POS Station records. As each station logs in and 
identifies itself, you set the appropriate sales options. 
 
For example, POS Stations in concession stands might not be able to sell tickets, and vice versa.  Here is a sample POS 
Station definition: 
 

 
The UNIQUE identifier given 
to this station is 
NORTH_WIND, an 
abbreviation for North 
Window.  POS ID’s can be 
up to 10 characters long, 
and must be UNIQUE.   
 
While not illegal, spaces are 
frowned upon. Use the 
underline key_instead.  
 
 
 

This station is set to sell Tickets and Gift Certificates, but NOT Memberships.  The only general retail category this station 
is allowed to see is MISC FEES. 
 
Configure all your stations throughout your facility, and manage them from a single location. 
 
 
Related Topics: 
Database Record Controls 
The POS Menu 
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Sending a Broadcast 
 
From the ADMIN Module or the INVENTORY Module, you can send a broadcast message that will be displayed on the 
bottom line of all active POS stations.  Enter the message you want to broadcast, or pull down and select from a list of 
frequently sent messages. 
 

 
 
This is a great way to call a POS operator to the manager’s office, to inform everyone of an early closing, or other unusual 
event. 
 
Related Topics: 
The POS Menu 
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Preset POS Broadcast Messages 
 
Operators at POS Stations can send broadcasts to other POS Stations, but ONLY from a selection of 5 pre-defined 
messages.  This way, you will not be getting a lot of useless “chatter” at your POS stations because Suzy and her 
boyfriend are working the registers.  Here is where you define the 5 allowable preset messages for POS Station 
broadcasts. 
 

 
 
In this example we listed ideas for preset broadcast messages, such as needing a Manager, or that a CHILD MISSING 
alert has been issued.  Enter your own messages to suit your needs. 
 
 
Related Topics: 
Database Record Controls 
The Intelli-Menu Builder 
The POS Menu 
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Clearing All Broadcasts 

 
 
Sometimes, after heavy use, the Broadcast Message Queue can be filled with so many messages that it would take hours 
to clear them.  Or, you might have an emergency broadcast that you want to send to all stations without waiting.  
 
When you need to clear all messages, follow these steps:  
 
From the POS Menu, Select Broadcasts.   
 
Select Clear All Broadcasts.  
 

 
 
 
 
You will be asked to confirm. 
 
 
 
 

 
 
Click YES to clear the broadcast queue. 
 
 
Related Topics: 
Send a Broadcast 
Broadcast Preset Messages 
The POS Menu 
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The Options Menu 

 
 
There are two options to set for the Inventory Module. 
1) Where your data is, and 
2) What background you would like to see on the Main Screen of the Inventory Module. 
 
For more information regarding these menu selections, refer to the topics below: 
 
 Data Source 
 Background 
  Custom Image 
  Default 
 
See Also: 
Your Data Source 
Selecting a Picture 
The Main Menu 
 
 Your Data Source 
The “Data Source” is the location you specify for the program to search for its database, report, configuration and other 
files.   
 

 
 
 
 
 
 
 
 
 
Upon installation, the default is the directory (or “Folder”) 
where you installed the program.   
 
If you are running in a networked environment, you may 
have to change the working directory on each station 
running the program.   
 
The directory you indicate should have been already 
created on the server by your network administrator.  Files 
needed for the program to work should already be copied 
there. 
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Once the Data Source has been changed, you must re-start the program, in order to load the new data. 
 
See Also: 
The Options Menu 
Selecting a Sample Dataset 
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BACKGROUND--Selecting a BMP or JPEG Picture File 
You are able to choose your own graphic image for certain areas of the program.  These images can be in Windows 
Bitmap (BMP) or JPEG (JPG) formats.  There are two instances when you are able to select images in the INVENTORY 
Module. 
 
1.  The background of the main screen of the Inventory Module.  Below is an example selecting the default image 
provided by NCS.  Create your own background, using a program, such as PAINTBRUSH, or other graphics editor. 

 
2.  When you assign an image to an inventory record.  Here is the example used for the inventory record, a Reese’s 
Peanut Butter Cup. 

 
Related Topics: 
The Options Menu 
Inventory Records 
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Default Background Image 
 
Each Module of the Trak Pro System (except the Validation and Redemption Module) can be set to use a specific 
background for the Main Menu Form.  You can set a look that is consistent throughout your facility.  Use an image with 
your company logo, or graphics that indicate the function of the module.  Change them seasonally to brighten up the day.  
Here is a little spot where you can use your imagination. 
 

 
 
Related Topics: 
Custom Image
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Selecting a Sample Dataset 
 
When Tick-It! Trak Pro is set up, you are given the opportunity to install any of seven different sample data sets, to 
evaluate the system with various ticketing applications.  At the start-up of any Tick-It! Trak Pro Module, you will be 
presented with a choice of data sets.   

 
 
 
 
 
 
 
NOTE:  Not all of these choices may 
be available to you, if they were not 
installed during the program set up. 
 
 
 
 
 
 
 
 
 
 
 

In addition to an “empty” data set to begin work for your own organization, the seven sample data sets are: 
 
Baseball 
This example uses the “Podemska Chicken Hawks” minor league ball club to illustrate typical sporting event ticketing.  
There is a 71 game season pre-programmed.  Their home stadium, Podemska Field, has 16,361 reserved seats and 
2000 general admission bleacher seats.  Concessions and souvenirs have also been added. 
 
Cineplex 
This sample uses a Movie Cineplex called the Stellar Cinemas.  There are 8 movie theaters and a pre-loaded schedule of 
popular movies.  All seats offered are General Admission.  Concessions and souvenirs have also been added. 
 
College Sports 
Podemska City College has two venues for its sporting events: 
(a)  Podemska Football Field with 36035 Reserved Seats and 2000 General Admission Seats 
(b)  Podemska Arena with 6967 Reserved Seats and 2000 General Admission Seats 
Concessions and souvenirs have also been added. 
 
Science Museum 
The Tri-City Science Museum serves as an example of typical museum ticketing.  The museum is mostly a general 
admission facility, with an IMAX theater and Planetarium. There are also some special events which require reserved 
seating.  Concessions and souvenirs have also been added. 
 
Performing Arts 
The AMB Performing Arts Center is a large facility with 3 different venues: 
(a)  The large Amphitheater, with 3000 General Admission Lawn Seats and 6421 Reserved Seats 
(b)  The Main Stage Theater with 699 Reserved Seats and 
(c)  The Bantam Theater, with 184 Reserved Seats. 
Concessions and souvenirs have also been added. 
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Motorsports 
The AMB Motorsports Speedway is home to all kinds of exciting racing.  Admission is mixed with 4000 General Admission 
Grandstand seats, as well as 2140 Reserved Seats along with Pit Access.  Concessions and souvenirs have also been 
added. 
 
Theme Park 
The World of Fun Amusement park is actually two parks in one!  There is World of Fun, a roller coaster type park, as well 
as “World of Water”, a super-splashing and water sliding Water Park.  Admission to the parks is separate.  Tickets can 
also be purchased for some reserved seating shows, and special park rides.  Concessions and souvenirs have also been 
added. 
 

 
 
 
Click to select your data set.  
 
 
 
 
 
 
 
In this example, the operator has 
selected the Science Museum Data 
set.  
 
 
 
 
 
 
 

 
The best way to evaluate Tick-It! Trak Pro, or initiate user training, is to select a sample data set that most closely 
matches your organization. 
 
 
See Also: 
Your Data Source 
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Database Record Operations 
When you are working with records in your Tick-It! Trak Pro database, you will see a consistent set of controls, and a 
consistent method of operations.  At the bottom of any record form, the following buttons are displayed: 
 

 
 
 
 
 
 
 
 
 
 
These buttons appear and work 
the same way for all records in 
your database. 
 
 
 
 
 
 
 
 
 

When a database record is initially called up, the fields will be locked.  You are prevented from editing the displayed data.   
 
 
Locked fields have a pale yellow background 
 

 
To edit any of the values, click on the green EDIT button, as shown above.  While in EDIT mode, the fields are unlocked. 
Their background will change to white.  

 
 
Unlocked fields have a white background 
 

 
Some fields have values which are assigned by the program, and cannot be changed by the operator.  These fields are 
always locked.  They are indicated by a pale blue background.  

 
 
Computer generated fields have a pale blue background. 
 

Typically, these are system ID fields, where the numbers are generated by the program.  They are displayed for your 
reference only 
Related Topics: 
Inventory Categories 
Inventory Records 
Supplier Records 
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The Help Menu 

 
 
This is the place to go to get answers to your questions about the program. Here you access the help reference, enable or 
disable tips, and view program version and system information. 
 
At any time during operation of Tick-It! Trak Pro, you are able to access the help contents by pressing the F1 key.  
 
See Also: 
Tips for Novice Users 
About the Program 
The Main Menu 
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Tips for Novice Users 
 

 
The “Tips” screen will appear upon entry 
to complex forms and other areas of the 
program.  Turn this feature on or off via 
the Help Menu.   
 
 
 
 
 
 
 
 
 
 
 

 
From the Help Menu, select Tips.  Click the box to show tips. Click again to disable the tips.  
 
 
Related Topics: 
The Help Menu 
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About the Program 
 

 
 
 
 
This pop-up window details the version 
number and licensing information for the 
currently running copy of the Program.  You 
can also view computer system information as 
will from this selection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
When calling for tech support, NCS personnel might request that you open this window to check on items such as the 
version number, etc.  By clicking on the SYSTEM INFO button, a detailed listing of your computer’s hardware and 
software manifest will be produced, as shown below: 
 

 
 
 
An NCS Tech Support 
representative might ask you 
to open this form, for a more 
detailed diagnosis of any 
problem you might be having. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
See Also: 
The Help Menu 
 


